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Title: Poppin’ Graphs that Excel 
Grade(s): 4 
Subject(s): Math 
Author: ICAC Team 
Overview: The class will collect data related to popcorn and use the data 

to construct bar, circle, and line graphs. The students will then 
use Microsoft Excel to graph the same data sets. 

Content Standards: MA(4) 15. Represent categorical data using tables and 
graphs, including bar graphs, line graphs, and line 
plots. 

MA(4) 17. Represent numerical data using tables and 
graphs, including bar graphs and line graphs. 

TC(3-5) 9. Use technology tools to organize, interpret, and 
display data. 

Local/National 
Standards: 

  

Primary Learning 
Objectives: 

Using a desktop or laptop computer and Microsoft Excel, 
students will create a bar graph, circle graph, and a line graph 
representing data collected concerning class members’ 
preferred popcorn flavor and volume of popcorn. 

Additional Learning 
Objectives: 

 

Approximate 
Duration of Lesson: 

90 Minutes – Can be divided into two 45 minute sessions 

Materials and 
Equipment: 

Pre-popped popcorn, bags for each group and baggies or 
small cups for each student, markers, chart paper or a dry 
erase board to record class data, data sheets and blank graph 
templates (see attached), measuring cup marked in oz. for 
each group, several different sized cups or similar containers 
(e.g. 8oz, 12oz, 16oz, etc.) - one per group. 

Technology 
Resources Needed: 

 
Desktop or laptop computer, Excel or other spreadsheet. The 
directions in this activity are based on Excel 2010. You may 
need to adjust your directions and illustrations if you are using 
a different version of Excel or different spreadsheet software. 

Background/ 
Preparation: 

 

 Popcorn should be popped and divided into different 
bags, one bag for each group plus individual baggies of 
popcorn for each student. 

 The class should have a basic understanding of graphs 
and charts. 

 The class should be familiar with the basics of using the 
Microsoft Excel software. 
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Procedures/ 
Activities: 

Step 1 Ask students “How many of you like popcorn?” 
List these popcorn flavors on the board or overhead: 
Plain, butter, caramel, chocolate, cinnamon, barbeque. 
Ask “Which flavor of popcorn is best?” Ask students 
how they could determine the most popular flavors.  
(Students should suggest that they survey people to 
see which kind they like.) 
 
Tell students that they need to decide which flavor of 
popcorn is the favorite in their group. They will poll 
their group members, record the choices, and graph 
the data on the graph paper that is handed out.  
 
Ask students to name several types of graphs. (They 
may suggest line graphs, bar graphs, and pie charts.) 
Ask them which type of graph they should use to 
display the results of their popcorn flavor survey? 
Before students conduct their surveys, tell students 
that you will review 3 important types of graphs and 
how to make them.  Be sure that they understand 
information about how graphs provide a visual display 
representing a relationship or trend. Have examples of 
bar graphs, circle graphs (pie charts), and line graphs 
on the board or overhead. Review as much of the 
following information as your students need. 
 
Graphs show the relationship between two sets of 
observations or measurements called independent 
(manipulated) and dependent (responding) 
variables. The independent variable is the one that 
you manipulate or control and the dependent variable 
is the one that responds to the manipulation and is 
measured.  For example, if you wanted to see the 
effects of different amounts of fertilizer on the growth 
of tomato plants, you might set up an experiment with 
four groups of plants.  You could add one teaspoon of 
fertilizer to one group of plants, 2 tsp. to a second 
group, 3 tsp. to a third group. The fourth group of 
plants would not get any fertilizer; it would serve as 
your control. You would then measure the growth of 
the plants over a period of time. 
 
Ask students “In this example what is the independent 
or manipulated variable? (The amount of fertilizer that 
you add.) 
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What is the dependent or responding variable?  (The 
growth of the tomato plants - how high they grow, or 
how many tomatoes they produce, etc.) 
 
When graphing data, the rule is to place the 
independent variable on the X (horizontal) axis, and 
the dependent variable on the Y (vertical) axis of the 
graph. 
 
In a vertical bar (or column) graph, the independent 
variable is a series of categories, e.g., colors such as 
red, green, blue, or teams, such as Tigers, Crimson 
Tide, or Blazers. The dependent variable shows the 
amounts in each category. On a bar graph you can 
easily see how the amounts of each category compare 
with all other categories by comparing the heights of 
the bars. 
 
A circle graph (pie chart) has categories just like a 
bar graph, but the number in each category is 
represented by the size of its slice of the pie instead of 
the height of a bar. Pie charts are used when the data 
represent 100% of the categories. Each slice of the pie 
represents the percentage for that category of the 
whole data set (pie). 
 
A line graph (or line plot) is a graph where both the 
independent variable and the dependent variable are 
numbers. Both the X and Y axes will be evenly 
divided into scales of numbers (1, 2, 3, 4 or 5, 10, 15, 
20, etc.) The line graph has a series of data points 
(dots on the graph) corresponding to the value of the 
dependent variable for each value of the independent 
variable. The dots may be connected with straight 
lines to show the fluctuations in the data, or a smooth 
line (line of best fit) may be drawn that averages the 
points and shows the overall trend of the data. 
 

Step 2 Tell students that you are going to collect some data 
from them to use to construct different types of graphs. 
Set up a table on the board or on your computer with 4 
categories for flavors of ice cream: vanilla, chocolate, 
strawberry, and butter pecan. Do a quick survey to 
determine the number of students who prefer each 
flavor and record the totals on the table.  Then on the 
board or on the graph template on your computer, 
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have students tell you how to construct a vertical bar 
graph with each flavor listed as a category on the X 
axis and a scale for the number of students on the Y 
axis. (You could set up the graph in advance using the 
Word Graph Template at the end of this lesson plan. 
Replace the Category names with the names of the 
ice cream flavors and eliminate the categories and 
numbers that you do not need.) 
Graph the data. Make sure that each axis is labeled 
and that the graph has a descriptive title (e.g., Favorite 
Flavors of Ice Cream). 
 
When the bar graph is complete, create a circle 
graph (pie chart) using the same data. Use the circle 
graph template (attachment) or draw a circle on the 
board. Demonstrate to students how to convert each 
category count into a percentage of the whole. (Divide 
the number of students in each category by the total 
number of students and multiply by 100 to get a 
percent.) The number in each category is represented 
by the size of its slice of the pie. The size of the slice 
may be estimated by referring to the lines on the circle 
graph template, which are marked off in 5% 
increments. Most pie charts have a key to indicate the 
names of the categories (slices).  
You can extend this activity by teaching students how 
to convert percentages into degrees (multiply 360 
degrees by the decimal percentage for each section of 
the pie) and how to use a protractor to determine the 
correct size for each section. 
 
Illustrate a line plot by showing the attached table on 
the accuracy of hitting a target bullseye with a piece of 
thrown popcorn. (If you have time, you could divide the 
students into groups, place a target on the floor, and 
collect real data to use for the graph.) Show the 
students the data table on your computer or copy it to 
the board. Plot the data in the table on the Graph 
Template. (You can set up the graph ahead of time by 
eliminating the category names and labeling each 
axis.) 

Step 3 Once you have gone over the graph examples, divide 
the class into groups of 3 or 4. Tell students that they 
will now collect some real data to use to construct 
graphs. Their first task is to decide which flavor of 
popcorn is the favorite in their group.  
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Handout the Student Data sheet and 3 sheets of graph 
paper (attached) and the supplies needed for the 
Popcorn Volume activity (bag of popcorn, measuring 
cup, large cup or other container). 
 
For Part A of the Activity, students will poll their group 
members, record their choices, and graph the data on 
the graph grid and on the circle graph paper that is 
handed out. 
 
For Part B, students will estimate and measure volume 
and capacity of popcorn for a measuring cup and 
another container, then construct a line plot on the 
graph grid that is handed out. 
 
Move around the room while groups are working to 
assess their graphs.  Remind them to label each graph 
with titles for the graph and each axis and to construct 
a key for the pie chart. 
 
When all groups have completed their graphs, have 
each group place their totals on the table on the board 
or overhead.  When all class data has been collected, 
have students fill-in their data sheets for the class 
totals. (These data will be used later to construct 
graphs using Microsoft Excel.) 
  
NOTE:  The lesson can be temporarily stopped here to 
be continued in a later session. 
 

Step 4 Tell students that we will now use Excel to create 
graphs of their class data. Each group of students will 
first create a bar graph and a circle graph using 
Microsoft Excel and the class data on favorite flavors 
of popcorn.  Make sure good collaboration is taking 
place in each group.  It might be beneficial to assign 
roles within each group if needed. 
 
Demonstrate how to open Microsoft Excel by clicking 
this icon:   
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The screen should load and then look like this:  

 
 
Tell students that they should now enter the class data 
from Table 2 into the “A” cells (which will become the 
horizontal X axis) and the “B” cells (vertical Y axis). 
 

 
 
Enter the popcorn flavors in cells A1, A2, A3, A4. 
Then enter the number of students who like each 
flavor in cells B1, B2, B3, B4. (sample data below) 
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Now, we will create the graph by highlighting the 
information in cells A and B (Begin by clicking the 
mouse at the top left corner of A1 and drag the mouse 
to highlight the data in each cell through B4). 
 
Next, click the “Insert” tab at the top left of the screen. 

 
 
Ask students which type of graph should be used to 
display the data, bar (column) graph or a line graph? 
Why? 
A vertical bar (column) graph should be used because 
the independent variable is categories (flavors of 
popcorn), not numbers.   
 
To create a vertical bar (column) graph, click on 
“Column” tab and choose a graph that shows several 
vertical columns: 

 
 
The graph will be generated on the spreadsheet. 
When finished the screen should look something like 
this: 
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Next we need to label the horizontal and vertical axes. 
Click on the “Layout” tab. 

 
 
Now click on the “Axis Titles” tab: 

 
 
Click on Primary Horizontal Axis Title and label the 
axis, Favorite Flavors of Popcorn. 
Click on Primary Vertical Axis Title, then click on 
Rotated Title and label the axis Number of Students. 
Your graph should look like this: 

 
 
NOTE:  It’s always a good idea to save your work as 
you go along. This is a good point to stop and save. 
Go to the “Home” icon and click on the “Save” tab. 
 
At this point the teacher should go around the room 
and check each group’s work. 

Step 5 Next, we will use the same data to create a circle 
graph (pie chart).  
Highlight the information in cells A and B (Begin by 
clicking the mouse at the top left corner of A1 and drag 
the mouse to highlight the data in each cell through 
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B4). 
Next, click the “Insert” tab at the top left of the screen 
and choose “Pie” as the type of graph. The graph will 
be generated on the spreadsheet. Add a title. To move 
the graph on the screen, click and drag it with the 
mouse so that both graphs are visible. 
 
When finished the screen should look something like 
this: 
 

 
 
Check to see that all groups have completed their 
graphs correctly. 
 

Step 6 
 

Tell students that they will now use Excel to create a 
Line Plot. 
Create a line plot graph showing the Class Total data 
in Table 4 showing the volume and number of pieces 
of popcorn each container will hold.  
 
 Excel refers to Line Plots as Scatter Plots. (The Line 
Graph in Excel is not a true line graph; it treats the 
independent variable as categories rather than 
continuous numbers.) To create a line plot, choose 
Scatter Plot. Highlight the two columns of numbers, 
then click on “Insert.” Repeat the steps that you used 
to create the column graph, however instead of 
choosing the “Column” tab choose the “Scatter Plot” 
tab. 
 

 
 

Favorite Flavors of Popcorn 

buttered 

salted 

plain 

caramel 
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Chose a plot that has dots connected by lines. 
 
The completed graph should look something like this: 
 

 
 
Remind students to save their work. 
 

Step 7 Closure: Have students summarize the characteristics 
of each graph type and when to use them. 
 

Attachments: Assessment Rubric 
Popcorn Lab Student Data Sheet 
Line Plot Example 
Bar and Line Plot Graph Templates 
Circle Graph Template 

Assessment 
Strategies: 

 
Attached. 

Extension: Have students collect other data and create other graphs and 
charts.  Some ideas might be for them to record how students 
get home either by bus, pick-up, or walk or have them record 
whether students bring a lunch from home or get a hot lunch 
from school.  To extend this activity into the home environment 
have them collect other types of data such as how often certain 
commercials are seen during a specific show or how much 
sleep they get each night for a week. 

Remediation: Have students label different types of graphs or provide them 
with the frame work for each graph and have them complete 
the graph based on the data. 
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Assessment for Poppin’ Graphs 

Score 1 2 3 4 

Participation No 
participation in 
the activity. 

Some 
participation, 
but did not 
work well with 
the group. 

Participated 
throughout activity, 
contributed to the 
successful 
outcome. 

Worked well 
with everyone 
in group, 
offered ideas, 
contributed to 
successful 
outcome. 

Charts/Graphs Did not 
complete a 
bar graph, 
circle graph, 
and line plot. 

Created a bar 
graph, circle 
graph, and 
line plot, but 
they contained 
more than two 
errors.   

Created a bar 
graph, circle 
graph, and line 
plot that accurately 
represented the 
data, but with one, 
or two, numerical 
or graphical errors. 

Created a bar 
graph, circle 
graph, and 
line plot that 
included all 
required 
elements of a 
graph and 
accurately 
represented 
the data. 
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Popcorn Lab Student Data Sheet 
Part A: Favorite Flavors 
 

1. Obtain 2 sheets of graph paper (one grid and one circle) for your group. 
2. Answer the following questions about your favorite flavors of popcorn. 

 
a. My favorite flavor of popcorn (from list below) is ______________ 

because _______________________________________________. 
 

b. My least favorite flavor of popcorn is ___________ because 
_______________________________________________. 
 

3. Determine the number of votes in your group for each flavor and record the 
group totals for each flavor in Table 1. 
 

     Table 1: Group Data  

 
Flavor of 
Popcorn 

Number in group 
picking this as 
 favorite flavor 

Number in group 
picking this as 

 least favorite flavor 

Plain   

Butter   

Caramel   

Chocolate   

Cinnamon   

Barbeque   

 
4. Use the results of your group survey to construct a vertical bar graph and 

a circle graph (pie chart) for the Favorite Flavor data in Table 1. 
  

5. Record your group data for favorite flavor on the Class Data Table on the board. 
  

6. Record the Class Data Totals in Table 2 below. (This table will be used for 
graphing in a later activity.) 
 

     Table 2: Class Data 

Flavor of Popcorn Number of classmates picking 
this flavor as their favorite 

GROUP:  1 2 3 4 5 6 TOTAL 

Plain        

Butter        

Caramel        

Chocolate        

Cinnamon        

Barbeque        
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Popcorn Lab Student Data Sheet – page 2 
 
Part B: Popcorn Volume 
 

1. Get the materials for this lab: large bag of popcorn, measuring cup, large drink 
cup or other container, sheet of graph paper grid. 

2. Estimate how many pieces of popcorn it will take to fill the measuring cup (8 oz) 
level to the top. _____________ 

3. Count how many pieces of popcorn it takes to fill an 8 oz measuring cup 
completely full. Record in Table 3. How close was your count to your estimate? 

4. Estimate how many pieces of popcorn it will take to fill the large drink cup or 
other container. ___________ 

5. Describe how you could determine the volume in oz of the large drink cup using 
the materials that you have. 
 

6. Describe how you could determine how many pieces of popcorn the large drink 
cup would hold without counting every piece. 
 

7. Record your group data for volume and # pieces on the Class Data Table on the 
board. 
  

8. Record the Class Data Totals from the board on Table 4 below. Use the Volume 
and # of pieces of popcorn data from this table to construct a line plot graph on 
your sheet of graph paper. 

 
Table 3: Volume and Popcorn Capacity of Containers 

Container Volume 
(ounces) 

# pieces of popcorn 
to fill container 

Measuring Cup 8 oz  

Large container   

   

 
Table 4: Class Totals: Volume and Popcorn Capacity of Containers 

Container Volume (ounces) # pieces of popcorn to 
fill container 

Measuring Cup 8 oz  

Group 1 Container   

Group 2 Container   

Group 3 Container   

Group 4 Container   

Group 5 Container   

Group 6 Container   
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Line Plot Example 

 

A target with a two-inch diameter bullseye was place on the floor.  Four students in a group took 

turns throwing a piece of popcorn at the bullseye from different distances from the target. The 

distance from the bullseye that the popcorn landed was measured for each trial. The average for 

the four students for each trial was calculated and recorded in the table below. 

 

Independent Variable: ________________ 

Dependent Variable:   ________________ 

Graph Type:       ____________________ 

 

 

     Table: Accuracy of Popcorn Throw from Different Distances 

Starting Distance 

from Target (in) 

Avg. Distance 

from Bullseye (in) 

12  0 

24  2 

36  5 

48  8 

60 12 

72 18 
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(Template for Bar Graphs and Line Plots. Insert Graph Title and Axis Titles and units. On Y Axis: Adjust number 

scale if needed. On X Axis for Bar Graph: delete the numbers and replace Categories in blue with appropriate 

Category names. For Line Plot: delete Category names and change numbers to appropriate scale if needed.)  
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 Name ________________________  
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Circle Graph 
Name: _________________________ 

Date: __________________________ 

 

   Title:  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

Each division = 5% of circle 
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